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Preface



Since its inception, AutoCAD has enjoyed a wide range of user base, making it the most popular CAD software in the world since the 1980s. AutoCAD’s widespread use is due to its logic and simplicity, which makes it easy to learn. It evolved through the years to become a comprehensive software application that addresses all aspects of engineering drafting and designing.

This book explores the 3D environment of AutoCAD, teaching the reader how to create and edit 3D objects and produce impressive im-ages. This book is ideal for advanced AutoCAD users as well as col-lege students who have already covered the basics of AutoCAD 2025.

This book is not a replacement for AutoCAD manuals but is consid-ered to be a complementary source that includes hundreds of hands-on practices to strengthen the knowledge learned and to solidify the techniques discussed.

At the end of each chapter, the reader will find “Chapter Re-view Questions” that are the same type of questions you may see in the Autodesk certification exam; so, the reader is invited to solve them all. Correct answers are at the end of each chapter.

This book contains six projects from several types of engineering. Solving them will allow the reader to master the knowledge learned. These projects are presented in metric and imperial units.



ABOUT THE COMPANION FILES



The companion files for this book contain the following (all of the companion files are available for downloading from the publisher with proof of purchase by writing to info@merclearning.com): 



	A link to retrieve the AutoCAD 2025 trial version, which will last for 30 days starting from the day of installation. This version will help you solve all practices and projects (if you are a college/university student, you might be able to download a student version of the software from www.autodesk.com)


	Practice files which will be your starting point to solve all practices in the book


	A folder named “Practices and Projects,” which you should copy to the hard drive of your computer


	Two folders of projects: “Metric” for metric unit pro-jects, and “Imperial” for projects using imperial units








About the Book



This book discusses the 3D environment and commands in AutoCAD 2025. Many AutoCAD users do not know the real capabilities of AutoCAD in 3D, leading them to use other software to build their 3D models, create lights, load materials, assign materials, and then create still rendered images and animation. This book aims to clear up this misleading idea about AutoCAD and to introduce the real power of AutoCAD in 3D.

At the completion of this book, the reader will be able to:


	Understand the AutoCAD 3D environment


	Create 3D objects using solids


	Create 3D objects using meshes


	Create 3D objects using surfaces


	Create complex solids and surfaces


	Edit solids and use other general 3D modifying commands


	Convert 3D objects from one type to another


	Create 2D/3D sections from 3D solids


	Use model documentation


	Create 3D DWF files


	Create cameras and lights


	Assign material and create rendered images


	Use and create visual styles


	Create animation files






CHAPTER 1

AutoCAD 3D Basics



In This Chapter



	How to use the 3D interface


	How to view the 3D model


	How to use UCS commands




1.1 RECOGNIZING THE 3D ENVIRONMENT



The user will use the same software to draw 2D objects and 3D models, but AutoCAD separates the two environments by applying two rules:

	Use 3D template files, which are acad3D.dwt and acadiso3D.dwt. These templates will help you set up the 3D environment needed to start building the desired 3D model.


	Use either the 3D Basic workspace or the 3D Modeling workspace. In this book we always use the 3D Modeling workspace to find the desired commands, because it encompasses tabs and panels that contain all AutoCAD 3D commands. 



The image below illustrates the two concepts:

[image: image]

1. Tabs and Panel of 3D

2. Workspace

3. Viewport Controls

4. View Controls

5. Visual Style Controls

6. UCS Icon

7. 3D Model

8. 3D Crosshairs

9. ViewCube

10. Navigation Bar


1.2 LOOKING TO YOUR MODEL IN THE 3D ENVIRONMENT



1.2.1 Using Preset Views

Viewing 3D models in AutoCAD is simple and effective. The first method of viewing your model is to use the ten Preset views built into AutoCAD, assuming:

	Positive Y-axis = North and Front


	Negative Y-axis = South and Back


	Positive X-axis = East and Right


	Negative X-axis = West and Left


	Positive Z-Axis = Top


	Negative Z-Axis = Bottom



AutoCAD provides six 2D orthographic views and four 3D views. The six 2D orthographic views are:

	Top


	Bottom


	Left


	Right


	Front


	Back



And the four 3D views are (look up to know where each direction is): 

	SW (South West) Isometric


	SE (South East) Isometric


	NE (North East) Isometric


	NW (North West) Isometric



To use these preset views, go to the top left part of the screen, select View Controls, select the desired preset view, see the illustration below:

[image: image]

The user can find these commands using the Home tab and View panel, but the above method is easier.


1.2.2 Using ViewCube

At the upper-right corner of each drawing, AutoCAD will show the ViewCube. ViewCube looks similar to the following:

[image: image]

By clicking each face of the cube, you will see a 2D orthographic view, as mentioned in the preset views. By clicking the upper corners of the cube, you will see an isometric view similar to SW, SE, NE, and NW. By clicking the lower corners of the cube, you will see the same views but from below. In addition to these views, ViewCube will allow you to look at the model from the edges of the cube. These are 12 views. The total will be 26 views.

[image: image]

Add to these 26 views a compass that will rotate the ViewCube CCW or CW.

[image: image]

AutoCAD saves one of the views as the Home view, which you can retain by clicking the Home icon:

[image: image]

Views are always related to the World Coordinate System (WCS) or to the User Coordinate System (UCS); hence, make sure you are at the right WCS or UCS (this topic is discussed at the end of this chapter). Click the pop-up list at the bottom of the ViewCube to see the following: 

[image: image]

Also, at the bottom right of the ViewCube, you will see a small triangle, which contains a menu to help you make some settings; see the following illustration:

[image: image]

You can do all or any of the following:

	Retain the Home view.


	Switch between the Parallel (60/30 isometric) view, Perspective view, or Perspective view with Ortho faces


	Change the Home view to be the current view.


	Modify ViewCube settings.


	Display ViewCube help topics.



If you select ViewCube Settings, you will see the following dialog box:

[image: image]

Set the following:

	The location of the ViewCube (default is top right).


	The ViewCube size (default is automatic).


	The Inactive Opacity (the default is 50%).


	whether to show the UCS menu or not.



The rest is self-explanatory.



PRACTICE 1-1



AutoCAD 3D Basics

	Start AutoCAD 2025. 


	Open Practice 1-1.dwg file


	Using Preset views, ViewCube (try all options), look at the 3D model to view it from all different angles.


	Save and close the file.




1.3 ORBITING IN AUTOCAD



Orbiting is to rotate your model dynamically using the mouse. There are three types of orbiting in AutoCAD. These are:

	Orbit


	Free Orbit


	Continuous Orbit



You will find all three commands by going to View tab, locating the Navigate panel, and clicking the Orbit button, as shown in the following (if this panel is not shown by default, show it first):

[image: image]


1.3.1 Orbit Command

Once you start the command, the mouse cursor will change to:

[image: image]

This command will allow you to rotate your model around all axes. Your limit will be the top view and the bottom view; you cannot go beyond them. This command will end by pressing [Esc].

Another way to do the same thing is by holding [Shift]+clicking and holding the Mouse wheel. 


1.3.2 Free Orbit

Refer to the image below. An arcball will appear, showing four circles at each quadrant. Zoom and pan using your mouse wheel to center your model at the arcball:

[image: image]

Depending on where you are around the arcball, you will see a different cursor shape.

You will see the following shape: [image: image] if you are at the circle at the right or left of the arcball. Click and drag the mouse to the right or left to rotate the shape around the vertical axis.

You will see the following shape: [image: image] if you are at the circle at the top or bottom of the arcball. Click and drag the mouse up or down to rotate the shape around the horizontal axis..

You will see the following shape: [image: image] if you are inside the arcball, which is similar to the Orbit command discussed above.

You will see the following shape: [image: image] if you are outside the arcball, which will allow you to rotate the model around an axis going through the center of the arcball and outside the screen. To end this command press [Esc].

Another way to access this command is by holding [Shift]+[Ctrl]+Mouse wheel. 


1.3.3 Continuous Orbit

When you issue this command, the mouse cursor will change to:

[image: image]

This command will allow you to create a nonstop movement of the model orbiting. All you have to do is to click and drag. Your model will start moving in the same direction you specified. To end this command, press [Esc]. 



1.4 STEERING WHEEL



The Steering Wheel will allow you to navigate the model using different methods like zooming, orbiting, panning, walking, and so on,

To issue this command, go to the View tab, locate the Navigate panel, and click the Steering Wheels button, as in the following:

[image: image]

Choose the Full Navigation option and you will see the following:

[image: image]

There are eight viewing commands, four located in the outer circle, and four located in the inner circle. In the outer circle, you will find the following:

	Zoom command


	Orbit command


	Pan command


	Rewind command



In the inner circle, you will find the following:

	Center command


	Look command


	Up/Down command


	Walk command




1.4.1 Zoom Command

This command will allow you to zoom in the 3D (although using the mouse wheel will do almost the same job). Move your cursor to the desired location of your model, start the Zoom option, click, and hold. Then move your mouse forward to zoom in and move your mouse backward to zoom out. 


1.4.2 Orbit Command

This is a similar command to the Orbit command. Move your cursor to the desired location, select the Orbit option, click, and hold. Move the mouse right and left, up and down, to orbit your model.


1.4.3 Pan Command

This command will allow you to Pan in 3D. Move your cursor to the desired location, select the Pan option, click, and hold. Move the mouse right and left, up and down, to pan your model.


1.4.4 Rewind Command

This command will record all your actions that took place using the other seven commands. When you use it, it is as if you are rewinding a movie. Start the Rewind command; you will see a series of screenshots. Click and drag your mouse backward to view all of your actions.


1.4.5 Center Command

This command will allow you to specify a new center point for the screen. (You should always hover over an object.) Select the Center option, click and hold; then locate a new center point for the current view. When done, release the mouse. As a result, the whole screen will move to capture the new center point.


1.4.6 Look Command

Assuming you are located in a place, and you are not moving, your head is moving up and down, left and right. Move the cursor to the desired location, select the Look option, click and hold; then move the mouse right and left, and up and down.


1.4.7 Up/Down Command

This command will allow you to go up above the model or down below the model. Move your cursor to the desired location; then select the Up/Down option. You will see a vertical scale. Click and hold and move the mouse up and down. 


1.4.8 Walk Command

This command will simulate walking around a place; you will have eight directions to walk through. If you combine this command with the Up/Down command, you will get the best results. Move your cursor to the desired location, select the Walk option, click and hold, and move the mouse in one of the eight directions.

The other versions of the Steering Wheel in the Navigate panel in the View tab are mini-copies of the Full Navigation. They are the following:

	Mini Full Navigation Wheel, which will show a small circle, contains all the eight commands


	Mini View Object Wheel, which will show a small circle, contains four commands of the outer circle in the full wheel.


	Mini Tour Building Wheel, which will show a circle, contains four commands of the inner circle in the full wheel.


	Basic View Object Wheel.


	Basic Tour Building Wheel.





1.5 VISUAL STYLES



Visual styles will decide how your objects will be displayed on the screen. The default visual style in 3D templates is Realistic. To issue this command, go to the top left side of the screen and click Visual Style Controls:
 
[image: image]

Another way to reach the same is to go to the Home tab, locate the View panel, then click the upper pop-up list:

[image: image]

AutoCAD is equipped with ten predefined visual styles (and you can create more):

	In 2D Wireframe visual style, you will see the edges of all objects. Lineweight and linetype of objects will be displayed.


	In Wireframe visual style, you will see the edges of all objects without lineweight and linetype.


	In Hidden visual style, it looks like Wireframe, but it will hide the obscured lines from the current viewpoint.


	In Conceptual visual style, objects will be shaded and smoothed.


	In Realistic visual style, objects will be shaded and smoothed; if materials are assigned, it will be shown with texture.


	In Shaded visual style, you will get the same result of Realistic but without texture.


	In Shaded with Edges visual style, you will get the same result as Shaded except the edges are highlighted.


	In Shades of Gray visual style, the color of all objects will be shades of gray.


	In Sketchy visual style, you will see lines of edges extended beyond their limit with jitter effect


	In X-Ray visual style, objects will look transparent as if you can see through them. 



The best way for you to become familiar with visual styles is to see them on the screen and experience the effects.

Using the View panel will allow you to see the effect of the visual style on the objects right away whenever you select the desired visual style.


NOTE


	Shaded and Shaded with Edges is equipped with the new cross platform 3D graphics system, it is faster, and clearer.


	When you choose Shaded and Shaded with Edges, you will see the word Fast beside the name like the below illustration:



[image: image]




PRACTICE 1-2



Orbit, Steering Wheel, and Visual Styles

	Start AutoCAD 2025.


	Open Practice 1-2.dwg file


	Using Steering Wheels, try to navigate through the high-rise buildings.


	Use different Orbit commands, try to rotate the high-rise building to see them from different angles.


	Using different visual styles, try to view the high-rise buildings with different looks.


	Save and close the file.





1.6 WHAT IS THE USER COORDINATE SYSTEM (UCS)?



In order to understand what UCS is, we must first discuss what WCS is. There is one WCS in AutoCAD, which defines all points in XYZ space, with XY as the ground, and Z pointing upward. Since in 3D we need to build complex shapes, we will need to work with all sorts of construction planes. That was the reason AutoCAD invented UCS. Who is the user? It is us. So, when an AutoCAD user needs to work in a plane, AutoCAD provides them with the power to create the desired UCS and create objects on it.

The relationship between X Y Z axes will remain the same; angles will remain 90 between axes, according to the right-hand-rule.  

Below is the UCS icon:

[image: image]

There are three ways to create a new UCS:

	Manipulating the UCS icon


	UCS command


	DUCS





1.7 CREATING A NEW UCS BY MANIPULATING THE UCS ICON



You can create a new UCS by manipulating the UCS icon. When you hover over the UCS icon, it will turn gold. To activate the process, click the UCS icon; it will change to the following:

[image: image]

As you can see, there is a grip at the 0,0,0, and three spheres at the end of each axis. If you hover over the grip, it will show the following:

[image: image]

There are three options to choose from:

	Move and Align: This option will allow you to move the UCS origin to a new location and align it with an existing face.


	Move Origin Only: This option will allow you to move the UCS origin to a new location.


	World: This option will allow you to retrieve the WCS. 



If you hover over one of the three spheres at the end of each axis, the following will be displayed:

[image: image]

User can do two things while in this menu:

	Redirect the axis (X, Y, or Z) by specifying a point.


	Rotate around the other two axes.



Using all the methods, whether using the grip at the 0,0,0, or the spheres at the end of each axis, will help you solve almost all the UCS case.

Check the following example:

You want to move and align UCS with the inclined face:

[image: image]

Click the UCS icon and hover over the origin grip; select the Move and Align option:

[image: image]

Move the mouse to align with the inclined face. Once the UCS is located in the right position, click once. You will receive the following result:

[image: image]

Now you will be able to draw on this plane. Refer to the following:

[image: image]


1.8 CREATING A NEW UCS USING UCS COMMAND



This command will create a new UCS based on information supplied by you, and it does not ask for objects to be drawn beforehand. This command offers so many ways to create a new UCS, which makes it a very important command for any AutoCAD user who wants to master 3D modeling in AutoCAD. We will discuss UCS options not according to their alphabetical order, but according to their importance. You can find all UCS options in the Home tab and Coordinates panel.


1.8.1 3-Point Option

To create any plane in XYZ space, you need three points. This fact makes this option the most practical when creating a new UCS. As the name of the option suggests, you will specify three points:

	New origin point


	Point on the positive X axis


	Point on the positive Y axis



To issue this command, select the 3-Point button:

[image: image]


1.8.2 Origin Option

This option will create a new UCS by moving the origin point from one point to another without modifying the orientation of the XYZ axes. To issue this command, select the Origin button:

[image: image]


1.8.3 X / Y / Z Options

These are three options but they are similar. So, we put them together. The idea is very simple; you will fix one of the three axes, and then rotate the other two to get a new UCS. But how will you know whether the angle you have to input should be positive or negative? We will use the second right-hand-rule, which states, “Point the thumb of your right hand toward the positive portion of the fixed axis; the curling of your four fingers will represent the positive direction.” In the picture below, we take Y as an example. To issue the Y command, select the Y button:

[image: image]


1.8.4 Named Option

If you use a certain UCS frequently, AutoCAD gives you the ability to name/save it. This will help you retrieve it whenever you need it. After creating the UCS, select the Named button:

[image: image]
 
You will see the following dialog box:

[image: image]

Under the Named UCSs tab, you will see a list of the saved UCSs, plus, Unnamed, World, and Previous. Unnamed is your current UCS, which you created before issuing this command. Click it to rename it; then type the new name. Then press [Enter]. You will see the following:

[image: image]

To end the command, click OK.

In the Coordinates panel, there is a list of the preset UCS. You will see your saved UCS among them, as shown in the following:

[image: image]


1.8.5 The Rest of the Options

The above options were the most important ones; therefore, we will go through the other options just to illustrate them: 

	World option will restore WCS:

[image: image]


	Z-Axis Vector option will create a new UCS by specifying a new origin and a new Z-Axis:

[image: image]


	View option will create a new UCS parallel to the screen (this is good if you want to input text for 3D model): 

[image: image]


	Object option will align the new UCS based on a selected object:

[image: image]


	Face option will create a new UCS by selecting face of a solid:

[image: image]


	Previous option will restore back the last UCS:

[image: image]



While you are hovering over the UCS icon, right-click; you will see the following menu:

[image: image]

You will see all the options discussed above. This is another way to reach the same commands.

































































Contents


	Cover page

	Half Title page

	License

	Title page

	Copyright

	Contents

	Preface

	About the Book

	Chapter 1 AutoCAD 3D Basics

	Chapter 2 Creating Solids

	Chapter 3 Creating Meshes

	Chapter 4 Creating Surfaces

	Chapter 5 Creating Complex Solids and Surfaces

	Chapter 6 Solid Editing Commands

	Chapter 7 3D Modifying Commands

	Chapter 8 Converting and Sectioning

	Chapter 9 Printing

	Chapter 10 Cameras and Lights

	Chapter 11 Material, Rendering, Visual Style, and Animation

	Index





OEBPS/css/page-template.xpgt
 

 
	 
		 
	

	 
		 
	

	 
		 
	

	 
		 
	

	 
		 
				 
			 
				 
		
	



 
	 






OEBPS/images/Auto_3D_ch01_42.jpg
Aligns the user coordinate system to a selected object

o UCS

Press F1 for more help






OEBPS/images/pub.jpg
MERCURY LEARNING AND INFORMATION

Boston, Massachusetts





OEBPS/images/Auto_3D_ch01_40.jpg
1518 bhm=te

Aligns the user coordinate system to a specified positive Z axis

o UCS

Press F1 for more help






OEBPS/images/Auto_3D_ch01_41.jpg
518 oo |8
-t b 131,

Aligns the XY plane of the user coordinate system with the screen

o UCS

Press F1 for more help






OEBPS/images/Auto_3D_ch01_35.jpg
Coordinateq

[mm UCSMAN
Press F1 for more help






OEBPS/images/Auto_3D_ch01_36.jpg
@ ucs

Named UCSs  Orthographic UCSs Settings

Current UCS: Unnamed

1® world

14 Previous
Part_Top
Right_Side

> b, I

Set Current
Details

Cancel

Help






OEBPS/images/Auto_3D_ch01_33.jpg
Defines a new user coordinate system by shifting the origin point

= UCS

Press F1 for more help






OEBPS/images/Auto_3D_ch01_34.jpg





OEBPS/images/Auto_3D_ch01_39.jpg
15 18 ts 1@
g t5 ttz
18+ West Side

Coordinates

UGS, World

Sets the current user coordinate system to the world coordinate

system
[ UCS

Press F1 for more help






OEBPS/images/Auto_3D_ch01_4.jpg





OEBPS/images/Auto_3D_ch01_37.jpg
@ ucs

Named UCSs  Orthographic UCSs  Settings

CurrentUCS: Left_Side

% World

14 Previous
Part_Top
Right_Side

l@ Left Side

‘ Set Current

0K

Cancel

Help






OEBPS/images/Auto_3D_ch01_38.jpg
-5 tnt3te
CRRCE AR
15+ |LeftSide
T_.,World
1op
@Bonom
@Left
(FRight
i;Front
gBack
Left_Side
Part_Top
Right_Side






OEBPS/images/Auto_3D_ch01_32.jpg
Defines a new user coordinate system using three points

o UCS

Press F1 for more help






OEBPS/images/Auto_3D_ch01_30.jpg





OEBPS/images/Auto_3D_ch01_31.jpg





OEBPS/images/Auto_3D_ch01_25.jpg





OEBPS/images/Auto_3D_ch01_26.jpg
Move and Align
Move Origin Only

World






OEBPS/images/Auto_3D_ch01_24.jpg





OEBPS/images/Auto_3D_ch01_29.jpg
Move Origin Only
World






OEBPS/images/Auto_3D_ch01_3.jpg
-1

1[Conceptual]

Custom Model Views »

Top
Bottom

Left
Right

Perspective

Front

Back

SW Isometric
SE Isometric
NE Isometric
NW Isometric

View Manager...

Parallel






OEBPS/images/Auto_3D_ch01_27.jpg
X Axis Direction ¥ Axis Direction Z Axis Direction
Rotate Around Z Axis Rotate around Z Axis Rotate Around ¥ Axis
Rotate Around ¥ Axis Rotate Around ¥ Axis Rotate Around ¥ Axis






OEBPS/images/Auto_3D_ch01_28.jpg





OEBPS/images/Auto_3D_ch01_22.jpg
..

2D Wireframe  Conceptual Hidden Realistic

Shaded Shades of Gray Sketchy

Wireframe

Save as a New Visual Style ...
Visual Styles Manager...






OEBPS/images/Auto_3D_ch01_23.jpg
(—][Custom View][Shaded with edges (Fast)]





OEBPS/images/cover.jpg
AUTOCAD 2025
3D MODELING

M. HAMAD





OEBPS/images/Auto_3D_ch01_20.jpg





OEBPS/images/Auto_3D_ch01_21.jpg
[-][Custom View][

Custom Visual Styles »

2D Wireframe
Conceptual
Hidden

Realistic
Shaded
Shaded with edges
Shades of Gray
Wireframe LS

X-ray

Visual Styles Manager...






OEBPS/images/Auto_3D_ch01_14.jpg





OEBPS/images/Auto_3D_ch01_9.jpg
Home

Parallel
Perspective

Perspective with Ortho Faces
Set Current View as Home
ViewCube Settings...

Help






OEBPS/images/Auto_3D_ch01_15.jpg
_GL





OEBPS/images/Auto_3D_ch01_7.jpg





OEBPS/images/Auto_3D_ch01_8.jpg
East Side =
WCs

+ | EastSide

New UCS





OEBPS/images/Auto_3D_ch01_18.jpg





OEBPS/images/Auto_3D_ch01_19.jpg
@ Pan

= (,9 Continuous Orbit ~
| Wheels 7| 4 Extents -

@ Full Navigation

@ Mini Full Navigation

@ Mini View Object
U )

@é Mini Tour Building

@ Basic View Object

@é Basic Tour Building
@l






OEBPS/images/Auto_3D_ch01_16.jpg





OEBPS/images/Auto_3D_ch01_17.jpg





OEBPS/images/Auto_3D_ch01_10.jpg
(@ ViewCube Settings

Display

On-screen postion: TopRight v

Small  Normal

Low ] High

When diicking on the ViewCube

Zoom to extents after view change

Jse view transitions when switching views

rient ViewCube to current UCS

Keep scene upright

]
Restore Defaults

Show compass below the ViewCube.

=

[wep ]






OEBPS/images/Auto_3D_ch01_1.jpg
E
3

o

¢ e @0
AL s
Layers -

%

properties 6 & 6 % &

Gizmo’

@
[ |

Nofiter  Move






OEBPS/images/Auto_3D_ch01_12.jpg





OEBPS/images/Auto_3D_ch01_6.jpg





OEBPS/images/Auto_3D_ch01_11.jpg
€ o[
(£ Orbit

Steering
Wheels

Na

(@D Free Orbit

Cp Continuous Orbit





OEBPS/images/Auto_3D_ch01_13.jpg





OEBPS/images/Auto_3D_ch01_45.jpg
World
Previous
Named UCS
Origin

3 Point
Rotate Axis
Z Axis

View

Face
Object

UCS Icon Settings





OEBPS/images/Auto_3D_ch01_43.jpg
18 1, 13 1@

Face

Aligns the user coordinate system to a face on a 3D solid

= UCS

Press F1 for more help






OEBPS/images/Auto_3D_ch01_44.jpg
1518 t, 12 10
ta, 12 13,

UCS, Previous
Restores the previous user coordinate system

= UCS

Press F1 for more help






OEBPS/images/Auto_3D_ch01_5.jpg





